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LDEF MINI-DATA BASE USER'S GUIDE

FOREWORD

Included in this document is a short user's manual for the LDEF Mini-Data Bases.

The user's manual contains examples from the actual data base records on specifically

how to access and work with the LDEF information. Compiling this information into

an easily accessible data base format, and making it available to the space community,

was a major task accomplished by the System and Materials Special Investigation effort

beginning in 1991. Boeing's activities were supported by the following NASA

Langley Research Center contracts; "LDEF Special Investigation Group Support"

contracts NAS1-18224, Tasks 12 & 15 (October 1989 through January 1991), NAS1-

19247 Tasks l&2 (May 1991 through October 1992), and NAS1-19247 Task 8

(initiated October 1992). Sponsorship for these programs was provided by National

Aeronautics and Space Administration, Langley Research Center, Hampton, Virginia

and The Strategic Defense Initiative Organization, Key Technologies Office,

Washington, D.C.

Mr. Lou Teichman, NASA LaRC, was the inital NASA Task Technical Monitor.

Following Mr. Teichman's retirement, Ms. Joan Funk, NASA LaRC, became Task

Technical Monitor. The Materials & Processes Technology organization of the Boeing

Defense & Space Group performed the five contract tasks with the following Boeing

personnel providing critical support during the program.

Bill Fedor

Sylvester Hill

Dr. Gary Pippin

Harry Dursch

Gail Bohnhoff-Hlavacek

Program Manager

Task Manager

Materials Special Investigation Group Lead

Systems Special Investigation Group Lead

Design and Development of Data Base,

Collation and Data Entry, Final Report and

User's Guide
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1.0. LONG DURATION EXPOSUREFACILITY (LDEF)MISSION PROFILE

TheLDEF wasalarge(about9 metersin length,4.3metersin diameter),reusable,

unmannedspacecraftdesignedto accommodatetechnology,science,andapplications

experimentswhich requirelong-termexposureto the spaceenvironment. LDEF was

transportedinto spacein thepayloadbayof a SpaceShuttle,free-flown in low Earth

orbit (LEO) for anextendedtimeperiod,andthenretrievedby aShuttleduringalater

flight. The LDEF waspassivelystabilized,andeachsurfacemaintaineda constant
orientationwith respectto thedirectionof motion.

The LDEF wasdeployedby the SpaceShuttleChallengerinto a 482 kilometers

nearlycircularorbit with a 28.4degreeinclinationon April 7, 1984. LDEF carried57

experimentsduring theplanned10-monthto 1-yearmission. A schematicdiagramof

the location(s)of eachexperimenton theLDEF is shownin figure 1. Dueto schedule

changesandthe lossof theSpaceShuttleChallenger,the durationof this flight was

extendedwell beyondtheoriginalplannedexposureperiod.

TheLDEF wasretrievedby theSpaceShuttleColumbiaon January12,1990after

spending69 monthsin orbit. In these69 months,LDEF completed32,422orbits of

Earthanddecreasedin altitudeto 340kilometers,whereit wasgrappled,photographed

extensivelyfrom theShuttlecrewcabin,andthenplacedin theShuttlepayloadbayfor

returnto Earth. TheLDEF remainedin thepayloadbayof theSpaceShuttleColumbia

for the landingatEdwardsAir ForceBaseandduring theferry flight to KennedySpace

Center(KSC). The LDEF wasremovedfrom Columbia at KSC and brought to the

SpacecraftAssemblyandEncapsulationBuilding (SAEF-2)wheretheLDEF andits

experimentswereexaminedvisuallyandphotographed,radiationmeasurementswere
conducted,andtheexperimentsremovedfrom thestructuretray by tray. Eachtraywas

photographedindividually subsequentto removal. Systemlevel testswerecarriedout

for particularexperimentsandsupporthardware.Externalsurfaceswereexaminedfor

evidenceof impacts,contamination,andotherexposureinducedmaterialschanges.

The trayswerethen shipped to the experimenters' laboratories for additional testing.

Published investigator's results from the 57 experiments were compiled onto the LDEF

mini-databases. The mini-data bases were continually updated with new information

and distributed to the LDEF community through December 1994.



2.0 DATA BASE INTRODUCTION

One of the main objectives of the LDEF Special Investigation Groups (SIGs) was to

develop LDEF data bases that identified the experiment objectives and hardware flown,

summarized experimental results and conclusions, and provided a system analysis

overview which would include spacecraft design guidelines and space environmental

effects. Compiling this information into an easily accessible data base format, and

making it available to the space community, was a major task accomplished by the

System and Materials SIG efforts beginning in 1991.

After a trade study of data base software packages, FileMaker Pro TM was chosen as

the data base software application program. FileMaker Pro is a data base manager

produced by Claris TM Corp, for both the Macintosh TM and IBM'rM-compatible

computers. Data between the two platforms is transparent, and the user interface is the

same. FileMaker Pro is a flat, text-retrievable data base that provides access to the data

via an intuitive user interface, without tedious programming. "Relational" data bases

were examined for this application, but found to have certain features too limiting for

this application.

Within the FileMaker Pro application, the LDEF information is placed within one of

five data bases including Optical Materials, Thermal Control Paints, Silverized Teflon,

Treated Aluminum Hardware, and the LDEF Environment. Within a data base, each

individual LDEF experiment or special investigation report has its own "record". Each

record contains specific information using "field name" headings, from which one can

view or print reports from the provided layout. The data bases were designed to be

easy to use, even though they contain detailed numerical data, interpretations and

conclusions of the principal investigators. Further the data bases are upgradeable, and

all information is traceable to a specific source as well as giving full acknowledgements

to the authors and principal investigators. All data can be viewed and downloaded into

other formats, but access to editing the data base is restricted to protect the information

content of the data base.

Included in this document is a user's manual for the LDEF Mini-Data Bases. The

user's manual contains pertinent excerpts from the Claris FileMaker Pro manual on

specifically how to access and work with the LDEF information. (For general

information on creating and updating databases, the readers are encouraged to consult



theClaris manualfor full FilemakerPro information.) TheUserGuideis divided up

into thefollowing sections:
• Installation

• Computerstart-upanddatabasepasswordaccess

• Checkingthememoryused

• Databaselayoutstructure

• Working with information

• Previewingandprinting

• Exchanginginformation

• Help function
• QuittingFileMakerPro

If the information from thesedata basesis usedin theproductionof a published

articleor proceedings,pleaseacknowledgethatthedatabaseswereusedandreference

it asbeingaproductof ContractNAS1-19247for NASA-LangleyResearchCenterby

the Boeing Defense & SpaceGroup, as well as the original source of the data
documentedin eachrecordof thedatabase.

3.0 INSTALLATION

TheseinstructionsassumetheuserhasreviewedtheClarismanualFileMaker Pro

Installation and the FileMaker Pro User Guide for the Macintosh computers. There

are two options for using the FileMaker Pro Installer for the Macintosh computers.

• Easy (complete) installation is the recommended method. The Installer installs the

entire FileMaker Pro package and puts all files and folders in their prefered locations--

some in the Claris folder in the system folder and some in the FileMaker Pro folder it

creates. If a Claris folder does not exist, the Installer creates one.

• Custom installation lets the user choose the files to be installed. The Installer puts all

files into the Filemaker Pro 2.0 Folder it creates.



4.0 COMPUTER START UP AND DATA BASE PASSWORD ACCESS

If working from a hard disk, open the FileMaker Pro folder and click on the

FileMaker Pro application icon. If you do not have a hard disk, insert the working copy

of the FileMaker Pro application disk in one drive, double click the disk icon, and

double click the FileMaker Pro application icon. Highlight the file name containing the

LDEF data base of interest (e.g. LDEF Optical Materials Data Base) and click it open.

Type the password "LDEF" and click okay. This password gives you access to read,

search the data base, download data to other formats, or print information from the data

base; the password does not give the user the ability to edit information in the data base,

or change the layout. This prevents user from inadvertently introducing errors into the

data.

Even though the Optical Materials Data Base will be used in the following examples,

this set of instructions can be used with any of the other diskettes as well. Simply

follow the directions, trying out your own examples. The following list outlines what

commands are available to the user, including the menu (in italics) where they can be

found.

Apple Menu: About the Finder or About the Macintosh

File Menu: New, Open, Close, Preferences, Change Password, Single User/

Multiuser, Page Set-Up, Print, Import/Export, Save A Copy As, Recover,

Quit

Edit Menu: Copy, Spelling

Select Menu: Browse, Find, Layout, Preview, Refind, View as List, Omit,

Omit Multiple, Sort

Window: Hide Window, Show Window

Note that in the following pages of this document the commands will be highlighted in

bold as they are introduced and discussed for easy reference.
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5.0 CHECKINGTHE AMOUNT OFMEMORY USED

From theApplemenuon theMacintoshdesktop(theFinderscreen),chooseAbout

The Finder if usingSystem6, or About This Macintosh if using System7. The

userwill seeasysteminformationwindow. If theuseris working on this setof data
basesor would like to work with multiple files, the usermight needto changethe

amountof memoryused.The Macintosh requires at least 1 megabyte of RAM available

to utilize the data basing function (with System 7, it requires 2MB of RAM and the

System 7 tune-up installed). Further, the FileMaker Pro application requires at least

1.2 MB of disk space to install; 4 MB of disk space for complete installation, including

HELP, utilities, and sample files.

6.0 LAYOUT STRUCTURE OF DATA BASE

The layout structure of the data base can be examined to get an overview of how the

data is organized into fields. By clicking on Layout in the Select Menu an empty

record appears showing just the field labels as shown in figure 2. You can familiarize

yourself with these field labels by using the tab button to move through the various

fields. Alternatively, review Appendices A-E which list the field labels for the five

different data bases.

7.0 WORKING WITH INFORMATION

To find all the LDEF experiment records for viewing, choose Find All from the

Select menu. FileMaker Pro displays one of the thirty-seven LDEF optical experiment

records stored in the data base. To move from one record to the next, click either the

bottom or top page of the book (to the left of the screen) to view each record. Or slide

the bookmark up and down to move more quickly through the records.

After using the Find All command, the user should be in the browse mode and

ready to read through the data in each record. (If you are not in Browse, choose

Browse from under the Select menu.) To read through that record, one can either use

the the up-down arrows on the right margin to scroll line by line; or use the push box

also in the right margin to move more quickly through the data. Alternatively a third

way to move from one field name to the next, is to use the Tab key. Examples of

browsing through a record are shown in figures 3, 4 and 5.



Forinstance,to find onespecificrecordfrom the thirty-sevenrecordsavailablein

theOpticalMaterialsDataBase,without having to go througheachandeveryrecord,

simply chooseFind from the Selectmenu. An emptyLDEF layout appearson the
screenasshownin figure 6. Dependingonwhatinformation is availableto theuserto

beginadatabasesearch,(i.e. nameof theprincipal investigator,experiment number,

etc.) beginby clicking on thefield namebox associatedwith that information. The

computerevaluatesonly thedata storedwithin this field namerecordfor thecriteriathe

userhasrequested.For example,afterclicking on theExperimentNumberbox, the

indicator bar begins blinking in that box. The user puts in the number of the

experimentof interest (e.g. S0050)and than clicks Enter or Find. The data base

instantlyretrievesthe S0050experimentrecords.Onecould havejust aseasily typed
theprincipal investigator'snamein thePresentPrincipalInvestigatorbox, andit would

havefound thesameexperimentrecords. Thecomputersearchresultsin five records

being found. While paging through theserecords,the userwill seetherecordsare

called S0050, S0050-1, S0050-2, S0050-3 and S0050-sum. These are either

subexperimentsof S0050,themainexperimentitself, or a summary.Of course, if the

user had by mistake typed the investigator's name in the Experiment Number box

instead of into the Present Principal Investigator box, no record would have been

found.

Try another example. This time use A0056 in the Experiment Number box. Notice

that to the left it says the computer correctly found only one record out of the thirty-

seven total Optical Materials Data Base records which satisfies the user's search

request.

Please note this data base uses a specific form of the alphanumeric code for the

LDEF experiment numbers. The experiment number designation uses a letter followed

by four numerals without spaces between letters and numbers for searching, e.g.

A0056. If the user mistakenly inputs AO 056 or AO056, the search will be blank.

Subexperiments follow the same designation with an affix that goes at the end of the

designation, e.g. S0050-1.

One can limit the search by inputting items in more than one Field name. For

instance, if the search began by inputting A0138 in the Experiment Number box, then

inputting the name Bourrieau in the Original Principal Investigator box, the computer

would have searched and found only one record...A0138-7. (This is sometimes

known as a logical AND search because it finds records that contain both this
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informationandthatinformation.) Entercriteriainto asmanyfields asneededto make

your requestspecific,andthenclick Find.

Any one of the field name boxes can be searched. Try typing in "fused silica" in the

Optical Materials box. The user will see that nine records out of the thirty-seven have

fused silica listed as a material that flew on LDEF.

Be aware that unless the user gets the exact search word in the correct field, the

search may come up blank. If one doesn't know which field to search in, the user

should not hesitate to search in a number of the possible fields. Then if the search word

still comes up blank in all the fields searched, try using a synonym, a broader term, or

other related words. The alternate search word may suggest a clue, that will lead the

user on the correct route within the data base to complete the original search. In other

words, do not hesitate to experiment with the data base, and be creative trying different

searches to find information.

In the event that one does not know the exact nomenclature to input to find records,

the user can augment a search by using the wildcard characters @ and *. For

instance, to find records with words that vary by one or more characters, use one

wildcard character @ for each unknown character. Or if the user is sure of all but one

character in a word, use @ to substitute for that character in the find request. To find

records with words that vary by more than one character, use the wildcard character *

Or if not sure of the number of or order of certain characters in a word, use * to

substitute for them in the find request. Remember though, wildcard searches take

longer to do--especially in a large data base. Wildcard searches are much faster if the

user specifies other criteria along with the wildcard criterion.

To find all the records that match one set of criteria OR another, you need to fill out

separate requests. For example, to find all records in the Optical Materials field that

contain the name "fused silica" OR "fiber optics", you need to use separate requests, or

it will look for only those records that satisfy both requests.

FileMaker Pro allows the user to put in actual numerical values for searching, as is

appropriate for the Cumulative Sun Hours field name box. In addition, the data base

allows the user to search the data base within a range of values, (e.g. between 11,000

and 15,000 Sun Hours), by using the range symbol (...). For example, type

"11,000...15,000", in the Sun Hours box and than click "Find". The computer finds
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eighteen of the thirty-seven records that have LDEF experiment records with
CumulativeSunHoursbetween11,000and15,000.

Also of interest, is the < and > searchcommands.The usercan searchfor all

numbersthat aresmaller than the numberinputtedby using <value,or all numbers

greaterthan the numberinputtedby using>value.Thesameis truefor words,where
<valuewill bewordsthat arealphabeticallybeforetheinputtedvalue,and>word will

bealphabeticallyafterthe inputtedvalue.(Theword valuein thiscaseis usedto show
wheretheword,numberor dateshouldbetyped.)

Mostof thesearchcommandsfrequentlyusedwith theLDEF mini-databaseshave
beendescribed. However,additional criteriafor finding recordscanbe found in the

ClarisFileMakerPromanual.

TheRefind commandunderthe File menuswitchesFileMakerProfrom Browse,

Layout, or Preview,to Find,anddisplaystherequestor groupof requeststhatwaslast

used.Onecanedit or addrequestsbeforecontinuingtheFindoperation.

The View as a List Commandunder the File menudetermineswhetherrecords

aredisplayedoneat atime or asacontinuouslist whenbrowsing.A checkmarknextto
thecommandnameindicatesthatView asaList ison.

TheSort commandundertheFile menuopensa dialoguebox thatallows theuser

to determinethesortorder---theorderin whichrecordsaredisplayedandprinted. The

databaseis generallyarrangedby theExperimentNumber,but this is easily changed

by usingthiscommandto sortbasedonarequirementof theuser.

TheOmit commandundertheFilemenuomits thecurrentrecordfrom therecords

beingbrowsed. Theomitted recordis not usedin calculatingtheresultsof summary

fields in therecordsyouarebrowsing. To seetheomittedrecordagain,theuserclicks
on theFind,Refind,FindOmitted,or FindAll commands.

The Omit Multiple commandundertheFile menuopensa dialoguebox thatlets

theuserdesignatethenumberof records,startingfrom thecurrentrecord,thatareto be

temporarilyleft outof thesetof recordsyouarebrowsing.Theomittedrecordsarenot

usedin calculatingtheresultsof summaryfieldsin therecordsyouarebrowsing. To
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seetheomitted recordsagain,theusercanuseFind,Refind,FindOmitted,or Find All
commands.

Two commandsareavailableunder theEdit Menu,despitethe passwordaccess

limitations. Those two commandsare Copy, and Cheek Spelling. The copy

commandcopies the selecteddata onto the Clipboard, replacing the Clipboard's

previouscontents. TheusercanthenusethePastecommandon anotherdatabaseor

softwareapplicationtopastetheselectionintoa newlocation.

The Check Spelling commandpresentsa submenuof commandsto check the

spellingautomatically.To checkspelling,FileMakerProneedsto beableto locatethe

Main DictionaryandtheUserDictionary.

The Window menu lets theuserselectanotherfile when severalareopen. The

namesof all openfiles arelistedon theWindowmenu.Files in parenthesesarehidden

files. Hide Window option will hide the window of any open file. When Hide

Window is chosen,thefile remainsopenbut thefile is not displayed. This option is

usedwith lookupfiles sotheyremainopenbutarenotdisplayed.

8.0 PREVIEWINGAND PRINTING

In preparingtheselectedLDEF databasematerialfor printing, asexhibitedon the
screen,FileMaker Proneedsto know whatprinter andpre-definedpapersizewill be

used.To specify a printer, use the Chooser function on the Apple menu. Then

choosePage Setup from theFile menu,which allows one to choosethepaper size

andotherdesiredprintingoptions,thenclick okay. Checkhow areportwill look when

printed by using the Preview command. Previewing eliminates errors without

wastingtime or paper.To do this:

1) Open LDEF data

2) Find and browse the records you want to print

3) Choose Preview from the Select menu.

With Preview the records look exactly as they will be printed. Move from page to

page by clicking the pages in the book or dragging the bookmark. Use the zoom

controls to zoom in to see objects on the screen in detail, or zoom out to get an

9



overview. To return to Browse,chooseBrowsefrom the Selectmenu. In summary,

to print copiesof theLDEF records,follow thissequenceof steps:

1) UseChooseron theAppleMenuto selectprinter, if necessary.

2) Browsetherecordsyouwant to print. UseFind,Omit, or FindAll asnecessary.

3) Sort the records,if necessary.FilemakerPro prints therecordsin the orderof the

LDEF databaselayout,unlessyouusethesortcommandto changetheorder.

4) ChoosePageSetupfrom the file menu,andmakeyour choicesin the PageSetup

dialogbox.
5) UsePreviewto checkreportbeforeprinting.

6) Goto File menuandchoosePrint.

7) A screenwill appearaskingtheuserfurtherquestionsaboutwhat is to beprinted.

For example,a usercanchooseto print just this record,or all recordsbeingbrowsed.

After makingthatchoice,click Okay. Thescreenwill tell theuserwhentheprinterhas

begunto print.

9.0 " EXCHANGING INFORMATION

FileMakerProallowstheuserto exchangeinformation (i.e.import/export)between
FilemakerProandmanyotherprograms.To import data,meansdatais broughtfrom

anotherapplicationor FileMaker Profile into aFileMaker Pro file. To export data,
meansdata is taken from a FileMaker Pro file and make it accessibleto another

application.

Theaccesspassword,"LDEF" givesa usertheability to exportdata,but doesnot

give the user the ability to import files into the LDEF data bases. This restriction is

incorporated into the data bases to protect the information content of the data base.

Performing the export procedure is fairly easy with any of the LDEF Mini-Data

Bases, since FileMaker Pro allows the user to save records in a variety of formats

(besides the standard FileMaker Pro format) which are compatible with the receiving

applications. Listed below are the available formats:

•Tab-separated text (word processing)

•Comma-separated text (ASCII characters)

oSYLK (spreadsheets like Microsoft TM Excel TM and WINGZ TM)

oDBF (dBASE TM format)
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•DIF (spreadsheetslike VisicalcTM and AppleWorks TM)

oWKS (worksheet format used by Lotus TM 1-2-3 TM)

•BASIC (variant of comma-separated text is a format developed to conform

to the Microsoft BASIC standard)

•Merge file (similar to the comma-separated text file format, this format can be

used in creating personalized form letters and other documents).

Here are the steps to follow to export data:

1) Open the ffle you want to export.

2) In Browse, choose Export from the File menu. (The Export dialog box appears.)

3) Type a name for the export file, and specify where you want it saved.

4) Choose the file type you want from the pop-up menu.

5) Click New. (You see the Field Order Dialog box.)

6) Move the fields into the order you want to export them.

7) Choose whether you want the fields formatted.

8) Click Okay. (A copy of the data is saved in this format.)

10.0 HELP FUNCTION

The Apple menu supplies on-line information about FileMaker Pro. In this menu,

the Help command displays the window for the Filemaker Pro Help System, which

provides information about FileMaker Pro commands, dialog boxes, and step-by-step

procedures for most common tasks. When open, Help appears in the Window menu.

The user can switch back and forth between Help and the FileMaker Pro file by clicking

the window the user wants to make active.

1 1.0 QUITTING FILEMAKER PRO

To leave the data base, simple choose Quit from the File menu. The user will

return to the main window.
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12.0 CONCLUSION

In conclusion,compiling datafrom theLDEF experimentsinto anorganizedformat

hasbeenaccomplished.The LDEF Mini-Data Bases have already proven to be an

effective research tool for the space community by providing easy transfer of LDEF

findings through the database.

The Materials SIG would be very interested in any questions, comments, or

suggestions you might have on the content or format of the data base, and any data you

might like to have inputted into the data bases. Please contact either Gail Bohnhoff-

Hlavacek (206)773-6892 or Gary Pippin (206)773-2846 of the Boeing Defense &

Space Group, P.O. Box 3999, M/S 82-32, Seattle, WA., 98124.
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<.4 selec_d op_caJ components performe.nce; (ind. to evaluate the results _nd impiic_ons of the meLsurements. _nd

est=tblish guidelines for selec_on of sp_=e elect'o.opdc_ systems. [ Ref 1] Also see the experiment objec_ves
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Experiment Tray S_n Houra: 8.200 [Ref 4]

Total M/O Impact Deneity (<.=. Brad > .5 mm in diameter): E_5 = 121 [Ref 13]

Original Pnncipel Inveetigatore:

M. Donald Blue, James J. GeJl_gher. R.G. _d_kelford

Geo_ie Instlute of Technology
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Atle.'_t_. Georgit 31:G3:2
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M. Donald Blue

Georgi_ Tech. Res. Insilu_e

Georgi_ _sl. of Technology
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Tel. (404)1_4-304_

Figure 3. Browsing through the data base information.

14



File F_it

Select Format Scripts Window 10:22AM

LDEF Optical Database i ji-

5

g

Records:

44

Found:

1

Unsorted

|igo[..lal[]

Reeulle Summ_lry:

GENERAL OBSERVATIONS: The _.y time to GTRI in pdsline condilion {except foe 1he slain de$clibed below)

and without _ngerpdn_. All ¢omponent_ sun4ved the tip without mecheni¢_l dilml_e. Micr_meteodte imp&cts wel_

seen on e. wide vLi_ety of oomponen_, The gneen epoxy-_bergllt_$ mounli_g $1_ip$ were chlLnged to a w_Jnut brown

where they were exposed to the splice en_ronment, Where oov_red, the originld Qreen Dolor we3 m_int_ned. ]l_e

='_y was covered wid_ a light coating of nico_ne st=iJn which is believed by NASA to be the result of Z308

thermid-con_'ol bl6z_ p_nt outgessing in the sp_ce environment end becoming lixed in plice by the effects of sole;

UV. The weight densib/of this materhd on the GTRI l='Ly hiL_ been estimated by Dr. G_e Hlu'vey of NASA !._RC to

be 02mg/a'n2. [Reference 5]

COMPONENT CHARACTERISTICS:

Lsse_. No Isser _on could be obtBJned from the HeNe and CO: _ubes. although they were in good physical

condi_on, suggeslJng that the mixture of f_ll ge__ hl_d changed dunng the period between ini_eJ end post-flight test_.

The GLA[As diode le.se_ indicated greLter light output, believed to be due to the new exper_mentig lu"r'engement.

r'_ther then improved diode performance. The G_AsP LED ch_,rL-_eds{c_ _ere unchanged between ini{_ _nd

post-_ight tests [Reference 3']. whether stored in our h_boratory or mounted on the LDEF t_.y The onginld

ch_rti_--lens_cs for both diodes are well reproduced. The stored diode hiL_ slightly greater quenlum effidency, while

the plL_c dome of the sp&ce exposed diode ¢an'ies the indentstJons of sml#l miereme_eon_es {Reference 7]

L=ser rods- YAG la._er rods were tested later because reme_uPemento! the Nd:YAG I_ser rods required

refurbishment of the odginaJ hL_er c_vity which hiEI detenom.ted. IReference 31 Three ND:YAG rods were induded in

the components set Two were mounted in _e _l_y beneath en _Juminum cover {simulling the minimum pro_clJon

e x petted in a typicl_ inst_JlatJon) while the third _as stored e__ a control Chat_c_riza_on of the rods assumes a linear

religion between input pump energy end output h_er-pulse energy with &n in_n:_pt on the pump-energy axis. The

mee, surernents pro_4de the slope end intercept d_Lr,_ctenzing this reh_onship between input end outpul energies for

the rods in spe,_fic posit_ons in the three-rod laser a_vity The required _._ty improvements made the o_ w more

effiaent, end the remeesured cow,dents india_d bet'_r performenoe then _e ongin_l measurements, "{he

spa=e-exposed rods _nd the control hid the same rels_ve change in mei_sured chlrectens_. The reli_onship

smong the rods remains the same _s in the ofiginaJ mea.surements. Even the 1/4-_. coa_ng on the ends of ea=h rod

sutured in good condi_on_ We condude th_.t the changes in pBPBmeters were due only to the changes in the c_vlty,

end that sps, ae expo;ure did not change the rod proper_es. [Reference 7].

Modul&tor_- O_er taser related components in this group indude den A DP {_mmonium-dihydrogen phosphate}

elecln3.oplJc modulstor No mes._ur_ble changes in op_c_J ln_nsmission were found with the ADP light modulator

The hBJf-wl_ve voi1_ge I_nd roU-off frequency were unahenged within expenmenl_J error;. [Reference 3]

Ril_hlarnp.s_- No changes were found in the proper_es post-reco'zery ]]he specln_ outputof the t_L_hlamp

reproduced _e or;gin_J rnetLsurements, [Reference 7]

De_ctor_- The HgCdTe detector performed better then previous me_.:;urements. _J_Jn due to en improwd test

set-up Measurements of en lnGsAsP photodiode indic:e.te good perform_e No sp_e-rel&_d degn_da_on

effects were found, Sev_r_ t_:le-a,"ea siticon photodiodes _nd PIN diodes were remeL,;ured. The onqin_

Figure 4. Browsing through data base information.
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Figure 5. Browsing through data base information.
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Figure 6. Using the Find command to find experiment S0050 on the data base.
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APPENDIX A.

FIELD DESCRIPTIONS FOR OPTICAL MATERIALS DATA BASE

Experiment Title: Name of experiment flown on LDEF.
Experiment Number: Number assigned the experiment by the LDEF Science Office.
Tray Location: Location coordinates where the experiment tray was located.
Experiment Objective: Goals of the specified experiment.
Original Principal Investigator: Name of the responsible investigator during the
assembling and launch of LDEF.
Present Principal Investigator: Researcher responsible for the LDEF experiment
post-flight.
AO Fluence: Atomic Oxygen fluences at end of mission for all row, longeron and
end bay locations including the fluence received during the retrieval attitude excursion.
Radiation Flux: Description of the amount of ionizing radition received at the
specific location.
Temperature: Description of the thermal environment at a specific tray location.
Experiment Tray Sun Hours: Cumulative equivalent sun hours for solar radiation
normal to the surface of the LDEF tray and longeron locations.
Total M/D Impact Density: Total number of meteroid and debris impacts <, =, or

> 0.5 mm in diameter resulting in a crater or disbonded area.
Optical Materials Flown: Optical material types flown on LDEF for the specified
experiment.
Measurements Performed on Samples: Type of experiments performed on the
samples during pre-flight, space flight and post-flight.
Results Summary: Experimental results extracted from the published papers and
compiled in the data base.
Conclusions: The Principal Investigator's (PI) and the PI team's interpretations of

results, words taken directly from their papers.
System Analysis and Future Design Considerations: Based on their own

findings, the principal investigator often gave suggestions for future spacecraft designs
which are recorded in the data base.

Additional Reading: Additional sources of information that are not already listed in
the reference section of the data base record.

References: Every piece of information in the data base has been referenced for
follow-up by the user.
PI's Database: Some investigator's created data bases for their individual
experiments. If that was the case, a note is made in this field to direct the user to
additional data bases.

Data Upgrade Date: As data is entered into a specific data base record, the date is

automatically recorded on the data base record.
Experiment Status: The status of the post-flight investigation on a specific
experiment.
Hardware Archive: This field describes where the samples and hardware are
physically located from a specific experiment.
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APPENDIX B.

FIELD DESCRIPTIONS FOR SILVERIZED TEFLON DATA BASE

Experiment Task: Objective of the specified LDEF experiment.
Task Investigators: Names of the responsible experiment investigators throughout
the mission.

Thermal Control Coatings: The type of material used as a thermal control coating.
Samples Provided to: Principal investigators gave samples to other laboratories for
additional analyses.
Location / Angle off RAM / AO Fluence / Sun Hours: Location coordinates
where the experiment tray was located. Incidence angles for LDEF tray and longeron
locations. Atomic oxygen fluences at end of the mission for all row, longeron, and end
bay locations including the fluence received during the retrieval attitude excursion.
Cumulative equivalent sun hours for solar radiation normal to the surface of the LDEF
tray and longeron locations.
Ionizing Radiation: Description of the amount of ionizing radiation which was
received at a specific location.
Thermal Environment: Description of the thermal environment at a specified tray
location.

Measurements Performed on Samples: Type of measurements performed on the
samples during pre-flight, space flight, and post-flight.
Results Summary: Experimental results extracted from published papers and
compiled in the data base.
Conclusions: Final interpretations of the Principal Investigator and associated team.
Ground Simulation Comparison Data: Describes what ground simulation tests
have been conducted for comparison to LDEF data.
References: Every piece of information in the data base has been referenced for
follow-up by the user.
Data Upgrade Date: As data is entered into a specific data base record, the date is
automatically recorded on the data base record.
Photographic Documentation Available: Describes what photographs are

available for this specific experiment.
Hardware Archive: Describes what LDEF hardware is available and where it is

stored for a specific experiment.
Meteoroid and Debris Impacts: Total number of meteroid and debris impacts <,

=, or > 0.5 mm in diameter resulting in a crater or disbonded area.
Experiment Number: Number assigned the experiment by the LDEF Office.
Figure 1. Important photographs, graphs, plots, etc. can be inputted into the data
base in this section.

Figure 2. "
Figure 3. "
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APPENDIX C.

FIELD DESCRIPTIONS FOR TREATED ALUMINUM DATA BASE

Experiment Task: Objectives of the specified LDEF experiment.
Treated Aluminum Material: Type of treated aluminum discussed in this record.
Task Investigators: Names of the responsible investigators on a specific LDEF
experiment throughout the mission.
Experiment Title: Title of specified LDEF experiment.
Experiment Number: Number assigned the experiment by the LDEF Science
Office.

Location / Angle Off RAM / Sun Hours: Location coordinates where the
experiment tray was located. Incidence angles for LDEF tray and longeron locations.
Atomic oxygen fluences at end of the mission for all row, longeron, and end bay
locations including the fluence received during the retrieval attitude excursion.
Cumulative equivalent sun hours for solar radiation normal to the surface of the LDEF
tray and longeron locations.
Result Summaries: Experimental results extracted from published papers and
compiled on the data base.
Measurements Performed on Samples: What type of measurements were

performed in the specified experiment
Conclusions: Final interpretation of data by the experiment investigators.
Ground Simulation Data: Describes what ground simulation tests have been
conducted for comparison to LDEF data.
Ionizing Radiation: Description of the amount of ionizing radiation which was

received at a specific location.
Temperature: Description of the thermal environment at a specific location on the
LDEF.

References: All data inputted into the data base has been referenced for follow-up
and/or traceability.
Data Upgrade Date: As data is entered into a specific data base record, the date is
automatically recorded on the data base record.
Sample Description: Details the samples used in analysis.
Photographic Documentation Available: Describes what photographs are
available for this specific experiment.
Hardware Archive: Describes what LDEF hardware is available and where it is

stored for a specific experiment.
Meteoroid and Debris Impacts: Total number of meteroid and debris impacts <,
=. or > 0.5 mm in diameter resulting in a crater or disbonded area.
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APPENDIX D.

FIELD DESCRIPTIONS FOR ENVIRONMENTAL DATA BASE

Mission: Formal NASA mission identification.

Mission Information: 1) Historical and background mission information, 2) overall
mission goals, and 3) general flight information.
Tray Numbering System: Experiment tray numbering system.
RAM Incidence Angle: Angle between the z-axis and the ram vector.
Atomic Oxygen Fluence for Trays and Longerons: Atomic oxygen fluences at
end of mission for all row, longeron, and end bay locations including the fluence
received during the retrieval attitude excursion.
Cumulative Equivalent Sun Hours: Cumulative equivalent sun hours for solar
radiation normal to the surface of the LDEF tray and longeron locations.
Thermal Environment: Description of thermal environment around the spacecraft:
a) maximum and minimum structure temperature, 2) space- and Earth-end
temperatures, 3) internal emissivity, 4) solar radiation, 4) albedo, 5) Earth radiation, 6)
space sink temperature, 7) average incident heat flux (solar + albedo) / Hr-FtSq by beta
angle at a specific tray location.
Radiation Environment: Description of the amount of ionizing radiation received at
specific locations on the spacecraft.
Micrometeoroid and Debris Impacts on LDEF: Total number of meteroid and

debris impacts <, =, or > 0.5 mm in diameter resulting in a crater or disbonded area.
Contamination Effects: A description of the impact of contamination on the

spacecraft.
Contamination Map: A map indicating the visible contamination on the spacecraft.

Radiation Environment I. Graph depicting the mission dose (Rads-tissue) versus
electron, proton and total.
Radiation Environment II. Fluence comparison graph depicting the LDEF mission

fluence (cm -2) versus depth in aluminum (g/cm2).

Radiation Environment Ill. Contribution to dose by source graph depicting the
LDEF Mission Tissue Dose versus the depth in aluminum.
Micrometeroid and Debris Impacts on Painted Metal: Drawing of the
resulting structure of an impact on painted metal.
Micrometeroid and Debris Impacts on Glass: Drawing of the resulting
structure of an impact on glass.
Micrometeroid and Debris Impacts on Thermal Blankets: Drawing of the
resulting structure of an impact on a thermal blanket.
LDEF Sources of Ionizing Radiation: Graph depicting sources of ionizing
radiation.

Vacuum Exposure: Details of the vacuum exposure of the spacecraft.
Gravity / Acceleration: Details of gravity and acceleration values.
References: Sources of the information in the data base.

Microenvironments: Details on the "microenvironments" surrounding the
spacecraft, e.g. accounts for local geometry variations and surface conditions affecting
atomic oxygen exposure such as for angle brackets, blanket edge attachments, copper
grounding straps, cover plates, etc.
Database Upgrade Date: Date the Environmental Data Base was last upgraded.
Contamination Studies: Several overview studies on contamination from a panel of
investigators studying the spacecraft.
Contamination References: References for the information contained in the

contamination study.
LDEF Activation Foils: Graph of activation foil data.
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AppendixD continued...

Variation of Solar Flux: Solar variation during LDEF mission, solar flux versus
missionday.
Cumulative Mission Fluences: Cumulative proton fluence versusmission day.
Directionality Radiation Exposure to Trapped Protons: LDEF mission
fluenceof
trappedprotonsversusprotonenergy(MeV).
Summary of Ionizing Radiation Dose on LDEF: LDEF mission dose (rads-
tissue)versusminimumshielding(g/cm2).
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APPENDIX E.

FIELD DESCRIPTIONS FOR THERMAL CONTROL COATINGS
DATA BASE

Experiment Number: Name of the specific experiment flown on the spacecraft.
Experiment Task: Goals of the specified experiment.
Thermal Control Coating: Specific coatings described in the database record.
Measurements Performed on Samples: Type of measurements performed on the

samples during preflight, space flight, and post-flight.
Results Summary: Experimental results extracted from published papers and

compiled on the data base.
Conclusions: Final interpretation of data by the experiment investigators.
Ground Simulation Comparison Data: Describes what ground simulation tests
have been conducted for comparison to LDEF data.
Location / Angle Off RAM/ AO Fluence / Sun Hours: Location coordinates
where the experiment tray was located. Incidence angles for LDEF tray and longeron
locations. Atomic oxygen fluences at end of the mission for all row, longeron, and end
bay locations including the fluence received during the retrieval attitude excursion.

Cumulative equivalent sun hours for solar radiation normal to the surface of the LDEF
tray and longeron locations.
Ionizing Radiation: Description of the amount of ionizing radiation received at the
specific location.
Temperature: Description of the thermal environment at a specified location.
References: All data inputted into the data base has been referenced for follow-up
and/or traceability.
Database Upgrade Date: As data is entered into a specific data base record, the date
is automatically recorded on the data base record.
Task Investigators: Names of the responsible investigators during the entire
experiment (assembly, pre-flight, flights, and post-flight).
Sample Description: A short description of the sample.
Photographic Documentation Available: What photographs are available and
how to access them.
Hardware Archive: Describes what LDEF hardware is available and where it is

stored for a specific experiment.
Figure 1: Important photographs, graphs, plots, etc. can be inputted into the data
base in this section.

Figure 2: "
Figure 3: "
Meteoroid and Debris Impacts: Total number of meteroid and debris impacts <,
=, or > 0.5 mm in diameter resulting in a crater or disbonded area.
Experiment Title: Title of specified LDEF experiment.
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